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Paper Set 1 · 19 Jun 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
The ratio of two numbers is 3 : 5. If each number is increased by 10,
the ratio becomes 5 : 7. Find the numbers.

A.  A. 15 and 25

B.  C. 15 and 20

C.  D. 12 and 25

D.  B. 12 and 20

✓

Q2 Quant
A car travels from Delhi to Jaipur at 60 km/hr and returns at 80
km/hr. If the total time taken for the journey is 8.75 hours, find the
distance between Delhi and Jaipur.

A.  C. 300 km

B.  A. 330 km

C.  D. 360 km

D.  B. 390 km

✓

Q3 Quant
Find the actual price of a dress if it is sold for ₹4,624 after a 32%
discount.

A.  D. ₹6,800

B.  C. ₹6,900

C.  B. ₹5,960

D.  A. ₹6,850

✓

Q4 Quant
The median of the data 5,8,12,15,20,34,36, is

A.  A. 10

B.  C. 15

C.  D. 20

D.  B. 25

✓

Q5 Quant
18 women can finish a work in 48 hours. How many women are
required to complete the same work in 36 hours?

A.  A. 21

B.  B. 24

C.  D. 22

D.  C. 23

✓

Q6 Quant
If 20% of a number is added to 48, then the result is the same
number. 75% of the same number is:328

A.  D. 45

B.  A. 55

C.  B. 75

D.  C. 65

✓

Q7 Quant
A and B working together can do a piece of work in 4 days. B alone
can do the same work in 8 days. How long (in days) will A alone take
to do thrice the work?2549

A.  C. 24

B.  B. 48

C.  D. 72

D.  A. 96

✓

Q8 Quant
₹509 is divided among Nitin, Asha and Aaditya in such a way that if
₹24, ₹22 and ₹19 are deducted from their respective shares, they
have money in the ratio 5 : 18 : 14. Find the actual share of Asha.

A.  D. ₹238

B.  C. ₹218

C.  B. ₹254

D.  A. ₹266

✓

Q9 Quant
If at the same rate of interest, in 2 years, the simple interest is ₹60
and compound interest is ₹70, then what is the principal (in ₹)?

A.  B. 90

B.  C. 85

C.  A. 83

D.  D. 94
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✓

Q10 Quant
₹610 amounts to ₹970 at a certain rate of simple interest in 3 years.
Find the interest (in ₹) for the given 3 years.

A.  A. 360

B.  C. 370

C.  D. 355

D.  B. 375

✓

Q11 Quant
A manufacturer sells a product to a wholesaler at a profit of 25%.
The wholesaler, in turn, sells it to a retailer at a profit of 25%, and the
retailer sells it to a customer at a profit of 28%. If the customer pays
₹804, what is the cost price (in ₹) of the product for the
manufacturer?

A.  C. 402

B.  A. 405

C.  B. 408

D.  D. 404

✓

Q12 Quant
The product of two consecutive positive integers is 380. If the
smaller of these two integers is represented by x, which of the
options will correspond to the equation for finding out the value of
x?

A.  C. x2 + x − 380 = 0

B.  D. x2 + x + 380 = 0

C.  A. x2 − x − 380 = 0

D.  B. x2 − x + 380 = 0

✓

Q13 Quant
A man is walking at a speed of 4 km/h. After every kilometer, he
takes rest for 47 minutes. How much time will he take to cover a
distance of 92 km?

A.  94 h 17 m

B.  91 h 18 m

C.  93 h 21 m

D.  96 h 19 m

✓

Q14 Quant

A.  C. 96,250

B.  D. 98,200

C.  A. 86,250

D.  B. 92,350

✓

Q15 Quant
Two pipes, P and Q, can fill a tank in 18 minutes and 20 minutes, respectively. If both pipes are opened simultaneously, then find the time taken
to fill the tank completely.

A.  

B.  

C.  

D.  
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✓

Q16 Quant

A.  D. 25

B.  C. 1

C.  A. 24

D.  B. 12

✓

Q17 Quant

A.  

B.  

C.  

D.  

✓

Q18 Quant

3162

A.  

B.  

C.  

D.  
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✓

Q19 Quant
Mr. Ramanujan planned his monthly expenditure for rent, food, education and savings in the ratio 3 : 2 : 5 : 2. Find the percentage of his
savings.

A.  

B.  

C.  

D.  

✓

Q20 Quant

A.  B. 8.26

B.  D. 13.11

C.  A. 14.03

D.  C. 5.14

GA

✓

Q21 GA
The Hirakud Hydroelectric Project is located in which of the
following districts of Odisha?

A.  A. Sambalpur

B.  C. Bargarh

C.  B. Jharsuguda

D.  D. Sundargarh

✓

Q22 GA
In July 2025, Income Tax Day in India was observed on which date?

A.  A. July 22

B.  D. July 23

C.  B. July 24

D.  C. July 25

✓

Q23 GA
In April 2025, which sand artist from Odisha became the first Indian
to win the Fred Darrington Sand Master Award, for contributions to
the art form?

A.  A. Manisha Swarnkar

B.  C. Sudarsan Pattnaik

C.  B. Prasad Sonawane

D.  D. Rajat Kumar

✓

Q24 GA
Which flagship initiative of the Government of Uttar Pradesh,
originally launched in 2020 to promote women’s safety and
empowerment and whose fifth phase commenced on 22 September
2025 during Shardiya Navratri, focuses on spreading legal
awareness and empowerment among girls?

A.  A. Beti Bachao Beti Padhao 2.0

B.  D. Mission Shakti 5.0

C.  B. Ladli Yojana

D.  C. Kanya Suraksha Abhiyan

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q25 GA
In the electrolytic refining of copper, which electrode acts as the
anode?

A.  C. Impure copper block

B.  A. Zinc plate

C.  D. Pure copper plate

D.  B. Carbon rod

✓

Q26 GA
Which of the following joint military exercises between India and
France took place from 18 June to 1 July 2025?

A.  D. Exercise Maitree

B.  A. Exercise Shakti

C.  B. Exercise Yudh Abhyas

D.  C. Exercise Cyclone

✓

Q27 GA
Which of the following options is INCORRECTLY paired?

A.  D. Nilgiri Hills – Tamil Nadu

B.  C. Aravalli Hills – Rajasthan

C.  B. Satpura Hills – Madhya Pradesh

D.  A. Cardamom Hills – Karnataka

✓

Q28 GA
Which Odisha district reported ~98% success under Lakhpati Didi in
May 2025?

A.  A. Khordha

B.  B. Nayagarh

C.  C. Puri

D.  D. Cuttack

✓

Q29 GA
The famous Hathigumpha inscription of King Kharavela is located at
which site in Odisha?

A.  D. Udayagiri Caves

B.  B. Dhauli Hills

C.  C. Konark

D.  A. Puri

✓

Q30 GA
Cryopreservation is a form of Ex-situ conservation that involves
which process?

A.  A. Shielding a protected area from pollutants using natural
buffers

B.  B. Placing endangered animals under 24/7 surveillance in a
reserve

C.  C. Storing organisms in liquid nitrogen at very low
temperatures

D.  D. Growing plant tissues in a sterile, artificial nutrient
medium

✓

Q31 GA
If the direction of current in a conductor is reversed while the
magnetic field remains the same, the force on the conductor will:

A.  C. Increase but in the same direction

B.  D. Decrease but in the same direction

C.  B. Reverse direction

D.  A. Become zero

✓

Q32 GA
In November 2025, which nation clinched its fourth Davis Cup title,
marking a historic third consecutive win in men’s tennis?

A.  C. Spain

B.  D. USA

C.  A. France

D.  B. Italy

✓

Q33 GA
Which layer of the Earth contains mostly silica and aluminium?

A.  B. Core

B.  C. Mantle

C.  A. Crust

D.  D. Inner core

✓

Q34 GA
Which step in photosynthesis leads to the formation of
carbohydrates?

A.  C. Reduction of carbon dioxide

B.  D. Oxidation of carbon dioxide

C.  A. Absorption of light

D.  B. Release of oxygen
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✓

Q35 GA
Which feature distinguishes a perennial river from a seasonal river?

A.  C. Originating from glaciers

B.  A. Continuous flow throughout the year

C.  B. High sediment load throughout the year

D.  D. Flowing only during monsoons

✓

Q36 GA
Ministry of Youth Affairs and Sports (MYAS) started the Target
Olympic Podium Scheme (TOPS) in which of the following years?

A.  D. 2019

B.  B. 2014

C.  A. 2010

D.  C. 2024

✓

Q37 GA
Which of the following terms was added to the Preamble of the
Indian Constitution by the 42nd Constitutional Amendment Act,
1976?

A.  A. Sovereign and Democratic

B.  D. Secular and Socialist

C.  C. Republic and Justice

D.  B. Liberty and Equality

✓

Q38 GA
Which country won the ICC Cricket World Cup 2011, hosted in India?

A.  A. Australia

B.  C. India

C.  B. Sri Lanka

D.  D. England

✓

Q39 GA
In which of the following years was the Prevention of Seditious
Meetings Act enacted to consolidate and amend the law relating to
the prevention of public meetings likely to promote sedition or to
cause a disturbance of public tranquillity?

A.  B. 1896

B.  A. 1901

C.  D. 1905

D.  C. 1911

✓

Q40 GA
In a village farm, even if a few workers leave the work, the total
agricultural production remains the same. This situation indicates
__________.

A.  B. Structural unemployment

B.  A. Seasonal unemployment

C.  D. Disguised unemployment

D.  C. Frictional unemployment
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English

✓

Q41 English
Select the most appropriate option to complete the given sentence.

She completed the assignment _______ because she had very little time left.

A.  A. reluctantly

B.  B. hastily

C.  C. fastly

D.  D. hardly

✓

Q42 English
Select the option that can be used as a one-word substitute for the given group of words.

Self-confidence or assurance, especially when in a demanding situation

A.  B. Gaucheness

B.  D. Insensitivity

C.  A. Awkardness

D.  C. Aplomb

✓

Q43 English
In the following question, a statement has been given with highlighted text. You are required to replace the text with the correct Idiom given in
the options.

Rajat is new in the office, so I would like a volunteer to guide him about the tasks.

A.  B. the whole nine yards

B.  D. show him the ropes

C.  A. throw in the towel

D.  C. turn a blind eye

✓

Q44 English
Select the option that can be used as a one-word substitute for the given group of words.

A person who is extremely idealistic and unrealistic in their plans

A.  B. Pragmatist

B.  D. Realist

C.  A. Quixotic

D.  C. Visionary

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q45 English
Rectify the given sentence by selecting the correct spelling of the underlined incorrectly spelt word.

We will have to spend at least 2 weeks doing the expriment.

A.  D. expariment

B.  A. experiment

C.  C. exprimant

D.  B. experimant

✓

Q46 English
Identify the antonym of the word given in bold:
The hapless tourist, having lost his passport and wallet, spent the entire day trying to contact his embassy.

A.  C. happy

B.  B. woeful

C.  A. unlucky

D.  D. ill-fated

✓

Q47 English
The following sentence is in the active voice. Choose the correct sentence that expresses the same meaning in passive voice.

The children are painting the walls.

A.  D. The walls is painted by the children.

B.  A. The walls are being painted by the children.

C.  B. The walls are painted by the children.

D.  C. The walls being painted by the children.

✓

Q48 English
Convert the following sentence from indirect speech into direct speech by filling in the blank with the correct word.

Indirect Speech: Ravi said that he was going to the market then.

Direct Speech: Ravi said, “____ going to the market now.”

A.  B. I am

B.  C. He is

C.  A. They are

D.  D. You are

✓

Q49 English
Choose the correct proverb to substitute the underlined segment of the sentence.
When Rina forgot her lines on stage, the teacher reminded her that doing a task time and again helps a person to become perfect.

A.  A. Practice makes perfect

B.  B. Make hay while the sun shines

C.  C. Rome wasn’t built in a day

D.  D. Where there’s a will, there’s a way

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q50 English

Read the passage and answer the questions that follow.

The first law of human nature is simple but powerful: we are driven by our emotions more than we realize. We like to think we are logical, but
often, our decisions are clouded by feelings like anger, envy, or sudden excitement. This is why we sometimes fall into self-destructive patterns
that we seem unable to control. To gain real power and control over our lives, we must first master this emotional self. The goal is not to
eliminate feelings, but to create a moment of mental space before reacting. We must learn to step back and observe our emotions without
letting them take over our thinking. When you feel a strong impulse, learn to pause. This practice of observation—looking within to see the
source of your troubling emotions—is how you begin to break those negative patterns. By accepting that irrationality is part of human nature,
you choose reason over impulse.

Identify the suitable title for the passage.

A.  D. The Economics of Trade

B.  C. Mastering the Emotional Self

C.  A. The Science of Emotions

D.  B. The Art of Being Emotional

✓

Q51 English
Identify the central theme of the passage.

A.  B. Awareness and control of emotions is essential.

B.  C. Decisions must be made impulsively.

C.  A. Emotions should be ignored completely.

D.  D. Anger and envy are signs of intelligence.

✓

Q52 English
Identify the structure of the passage.

A.  B. A catalogue of emotional events

B.  D. A fictional presentation of human emotions

C.  A. Author's journey of self realization

D.  C. Analytical explanation with moral guidance

✓

Q53 English
Select the statement that summarizes the passage.

A.  D. The passage teaches methods of mental exercises only.

B.  C. The passage argues that emotions are useless and should be removed.

C.  A. The passage explains how controlling emotions leads to self-mastery.

D.  B. The passage narrates famous emotional outbursts in human history.

✓

Q54 English
Identify the tone of the passage.

A.  C. Bitter and resentful

B.  D. Wise and instructive

C.  B. Sarcastic and mocking

D.  A. Jovial and joking

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q55 English
Select the most appropriate antonym of the underlined word in the given sentence.
After the warning, the soldiers became vigilant and watched the camp carefully.

A.  A. Careless

B.  D. Watchful

C.  B. Authentic

D.  C. Attentive

✓

Q56 English
Complete the sentence by selecting the appropriate option:
The teacher ______ the students to revise thoroughly before the final examination.

A.  D. advised

B.  B. constructed

C.  C. borrowed

D.  A. discovered

✓

Q57 English
Choose the sentence which is correctly written in Future Tense.

A.  A. I will went to the market in the evening.

B.  D. I will gone to the market in the evening tomorrow.

C.  C. I will go to the market in the evening.

D.  B. I will be gone to the market in the evening.

✓

Q58 English
The first segment of the sentence is fixed. Rearrange the other segments (labelled P, Q, R, S) by choosing the correct option to form a coherent
and meaningful sentence.

Fixed Segment: After finishing his homework

P. younger sister, and together, they worked on the
Q. that impressed their teacher the next day
R. early in the evening, Rahul decided to help his
S. science project and created a simple model

A.  B. RPSQ

B.  D. QRSP

C.  C. PRSQ

D.  A. SRPQ

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q59 English
Rearrange the segments (labelled P, Q, R, S) by choosing the correct option to form a coherent and meaningful sentence.

P. carefully, and began working on the task with full concentration
Q. gathered their materials, reviewed their strategies
R. hoping to complete it efficiently within the limited time provided
S. as soon as the announcement was made, the participants

A.  B. SPRQ

B.  C. SRPQ

C.  A. SQPR

D.  D. RQSP

✓

Q60 English
Complete the sentence by inserting the correct article.

___ museum in ____ city centre is closed for renovation.

A.  A. The, no article needed

B.  C. The, the

C.  D. No article needed, the

D.  B. No article needed, no article needed

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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Odia

✓

Q61 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ମୋ କଥା ତୁ ମେ କାହିଁକି  ମାନୁ ନାହଁ  ?

A.  C. Why you were not listening me?

B.  A. Why don't you listen ?

C.  D. Why are you not listening?

D.  B. Why don't you listen to me?

✓

Q62 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

1960 ଦଶକରେ ଆରମ୍ଭ ହୋଇଥି ବା ସବୁ ଜ ବି ପ୍ଳବ ଭାରତରେ ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  କୃ ଷି  ପରି ବର୍ତ୍ତ ନର ସମୟ ଥି ଲା । ବୈ ଜ୍ଞାନି କ ଡକ୍ଟର ଏମ୍ .ଏସ୍ . ସ୍ୱାମୀନାଥନ ଙ୍କ ନେତୃ ତ୍ଵ ରେ ଏହି  ଅଭି ଯାନ ର
ଶୁ ଭାରମ୍ଭ ହୋଇଥି ଲା ତେଣୁ  ତାଙ୍କୁ  "ଭାରତରେ ସବୁ ଜ ବି ପ୍ଳବର ଜନକ" ବୋଲି  କୁ ହାଯାଏ | ଏହାର ପ୍ରା ଥମି କ ଲକ୍ଷ୍ୟ ଥି ଲା ଖାଦ୍ୟ ଉତ୍ପାଦନ ବୃ ଦ୍ଧି  କରି ବା ଏବଂ ମୁ ଖ୍ୟ ଫସଲ, ବି ଶେଷକରି  ଗହମ
ଏବଂ ଧାନରେ ଆତ୍ମନି ର୍ଭ ରଶୀଳତା ହାସଲ କରି ବା। ସବୁ ଜ ବି ପ୍ଳବ ପୂ ର୍ବ ରୁ , ଭାରତ ବାରମ୍ବାର ଖାଦ୍ୟ ଅଭାବ, କମ କୃ ଷି  ଉତ୍ପାଦକତା ଏବଂ ଆମଦାନୀ ଉପରେ ଅତ୍ୟଧି କ ନି ର୍ଭ ରଶୀଳତାର ସମ୍ମୁଖୀନ
ହେଉଥି ଲା। ଏହି  ସମୟ ମଧ୍ୟରେ ପ୍ର ଚଳି ତ ନୂ ତନ କୃ ଷି  ରଣନୀତି  ଦେଶର ଖାଦ୍ୟ ପରି ସ୍ଥି ତି ରେ ଏକ ଉଲ୍ଲେଖନୀୟ ପରି ବର୍ତ୍ତ ନ ଆଣି ଥି ଲା।

ସବୁ ଜ ବି ପ୍ଳବର ମୁ ଖ୍ୟ ବୈ ଶି ଷ୍ଟ୍ୟଗୁ ଡ଼ି କ ମଧ୍ୟରେ ଉଚ୍ଚ-ଅମଳକ୍ଷମ କି ସମ (HYV) ବି ହନ ପ୍ର ଚଳନ, ରାସାୟନି କ ସାର ଏବଂ କୀଟନାଶକର ବ୍ୟାପକ ବ୍ୟବହାର, ଉନ୍ନତ ଜଳସେଚନ ସୁ ବି ଧା ଏବଂ
ଟ୍ରା କ୍ଟର ଏବଂ ଅମଳକାରୀ ଭଳି  ଆଧୁ ନି କ ଯନ୍ତ୍ରପାତି  ବ୍ୟବହାର ଅନ୍ତର୍ଭୁ କ୍ତ ଥି ଲା। ଏହି  ବୈ ଜ୍ଞାନି କ ପଦ୍ଧତି ଗୁ ଡ଼ି କୁ  ସାର ଏବଂ ବି ଦ୍ୟୁ ତ ଉପରେ ସବସି ଡି , କୃ ଷି  ବି ଶ୍ୱବି ଦ୍ୟାଳୟ ପ୍ର ତି ଷ୍ଠା ଏବଂ କୃ ଷକମାନଙ୍କ
ପାଇଁ  ଋଣ ସୁ ବି ଧାର ବି ସ୍ତାର ଭଳି ସରକାରଙ୍କ ଦୃ ଢ଼ ନୀତି  ଦ୍ୱାରା ସମ୍ଭବ କାରାଯାଇପାରି ଥି ଲା।

ଏହି  ଆନ୍ଦୋଳନ ପ୍ରା ରମ୍ଭରେ ପଞ୍ଜାବ, ହରି ୟାଣା ଏବଂ ପଶ୍ଚି ମ ଉତ୍ତର ପ୍ର ଦେଶ ଭଳି  ଉନ୍ନତ ଜଳସେଚନ ଭି ତ୍ତି ଭୂ ମି  ଥି ବା ରାଜ୍ୟଗୁ ଡ଼ି କରେ କାର୍ଯ୍ୟ କାରୀ କରାଯାଇଥି ଲା । ଏହି  ଅଞ୍ଚଳଗୁ ଡ଼ି କ ଖୁ ବ ଶୀଘ୍ର
ଭାରତର ଖାଦ୍ୟ ଶସ୍ୟ ଉତ୍ପାଦନରେ ପ୍ର ମୁ ଖ ଯୋଗଦାନକାରୀ ଭାବେ ଉଭା ହୋଇଗଲେ। ଫଳସ୍ୱରୂ ପ, ଗହମ ଉତ୍ପାଦନ ବୃ ଦ୍ଧି  ପାଇଲା, ଏବଂ ଭାରତ, ଯାହା ଥରେ ଖାଦ୍ୟ ସହାୟତା ଉପରେ
ନି ର୍ଭ ରଶୀଳ ଥି ଲା, 1970 ଦଶକ ସୁ ଦ୍ଧା ଶସ୍ୟ ଉତ୍ପାଦନରେ ସ୍ୱାବଲମ୍ବୀ ହୋଇଗଲା।

ତେବେ , ସବୁ ଜ ବି ପ୍ଳବର ମଧ୍ୟ ଅନେକ କି ଛି  ଅସୁ ବି ଧା ଥି ଲା। ରାସାୟନି କ ସାର ଏବଂ କୀଟନାଶକର ଅତ୍ୟଧି କ ବ୍ୟବହାର, ମୃ ତ୍ତି କା ଅବକ୍ଷୟ ଏବଂ ଜଳ ପ୍ର ଦୂ ଷଣର କାରଣ ହୋଇଥି ଲା। କି ଛି  ଫସଲ
ଉପରେ ଧ୍ୟାନ ଦେବା ଦ୍ୱାରା ଜୈ ବ ବି ବି ଧତା ହ୍ରା ସ ପାଇଲା, ଏବଂ ଛୋଟ ଚାଷୀମାନେ ପ୍ରା ୟତଃ ମହଙ୍ଗା ଉପକରଣ କି ଣି ବା ପାଇଁ  ସଂଘର୍ଷ  କରୁ ଥି ଲେ। ଏହି  ସୀମାବଦ୍ଧତା ସତ୍ତ୍ୱେ, ସବୁ ଜ ବି ପ୍ଳବ
ଭାରତର ଖାଦ୍ୟ ସୁ ରକ୍ଷା ସୁ ନି ଶ୍ଚି ତ କରି ବାରେ ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରି ଥି ଲା ​​ଏବଂ ଭବି ଷ୍ୟତର କୃ ଷି  ଉନ୍ନତି  ପାଇଁ  ମୂ ଳଦୁ ଆ ସ୍ଥାପନ କରି ଥି ଲା। ପରି ଶେଷରେ, ସବୁ ଜ ବି ପ୍ଳବ ଭାରତର କୃ ଷି
ଇତି ହାସରେ ଏକ ମୋଡ଼ ନେଇଥି ଲା, ଏହାକୁ  ଏକ ଖାଦ୍ୟ ଅଭାବୀ ଦେଶରୁ  ଏହାର ବର୍ଦ୍ଧିତ ଜନସଂଖ୍ୟାକୁ  ଖାଦ୍ୟ ଯୋଗାଇବା ପାଇଁ  ସକ୍ଷମ ରାଷ୍ଟ୍ରରେ ପରି ଣତ କରି ଥି ଲା।

ଭାରତରେ ସବୁ ଜ ବି ପ୍ଳବ କେଉଁ  ଦଶକରେ ଆରମ୍ଭ ହୋଇଥି ଲା?

A.  C. 1940

B.  D. 1950

C.  A. 1960

D.  B. 1970

✓

Q63 Odia
ସବୁ ଜ ବି ପ୍ଳବରୁ  କେଉଁ  ଫସଲ ସର୍ବା ଧି କ ଲାଭବାନ ହୋଇଥି ଲା?

A.  D. କପା

B.  B. ଗହମ

C.  C. ଆଖୁ

D.  A. ମକା
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✓

Q64 Odia
"ଭାରତରେ ସବୁ ଜ ବି ପ୍ଳବର ଜନକ" ବୋଲି  କାହାକୁ  କୁ ହାଯାଏ ?

A.  B. ଡକ୍ଟର ଏ.ପି .ଜେ. ଅବଦୁ ଲ କଲାମ

B.  C. ଡକ୍ଟର ଏମ୍ .ଏସ୍ . ସ୍ୱାମୀନାଥନ

C.  A. ଡକ୍ଟର ବର୍ଗୀ ସ୍  କୁ ରି ଏନ୍

D.  D. ସି . ସୁ ବ୍ର ମଣ୍ୟମ୍

✓

Q65 Odia
ସବୁ ଜ ବି ପ୍ଳବର ପ୍ର ମୁ ଖ ଲାଭଦାୟକ ରାଜ୍ୟ କେଉଁ  ଥି ଲା?

A.  C. ବି ହାର

B.  B. କେରଳ

C.  A. ପଞ୍ଜାବ

D.  D. ଓଡ଼ି ଶା

✓

Q66 Odia
ସବୁ ଜ ବି ପ୍ଳବର ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ନକାରାତ୍ମକ ପ୍ର ଭାବ ପକାଇଥି ଲା?

A.  C. ଖାଦ୍ୟ ଉତ୍ପାଦନ ବୃ ଦ୍ଧି

B.  A. ମୃ ତ୍ତି କା ଅବକ୍ଷୟ

C.  D. ଉନ୍ନତ ଜଳସେଚନ

D.  B. HYV ବି ହନର ବ୍ୟବହାର

✓

Q67 Odia
" ଏ ବର୍ଷ ର ମଳୁ  ଆରବର୍ଷ କୁ  ବଇଦ"- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  B. ପ୍ର ତି ବର୍ଷ  ନୂ ଆ କଥା ଶି ଖି ବା ଆବଶ୍ୟକ ।

B.  A. ପୁ ରୁ ଣା ଜି ନି ଷର ମୂ ଲ୍ୟ ଅଧି କ ।

C.  C. ବୃ ଦ୍ଧ ଲୋକମାନେ ସବୁ ଠାରୁ  ଧନୀ ।

D.  D. ଅଭି ଜ୍ଞତା ହିଁ ପ୍ର କୃ ତ ଶି କ୍ଷକ ।

✓

Q68 Odia
ତତ୍ସମ ଶବ୍ଦଟି କୁ  ଚି ହ୍ନି ତ କର ?

A.  C. ଘୃ ତ

B.  B. ମାଟି

C.  A. ଘି ଅ

D.  D. ଗହମ

✓

Q69 Odia
'ଦର୍ଶ ନ କଲେ' - ଏହା ଏକ 'ମି ଶ୍ର  କ୍ରି  ୟା'। ଏହାର 'ଅମି ଶ୍ର  କ୍ରି  ୟା' ରୂ ପଟି  କଣ ହେବ?

A.  D. ଦେଖି ଲେ

B.  B. ଦେଖାହେଲେ

C.  A. ଦେଖି ବା

D.  C. ଦେଖୁ ଛନ୍ତି
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✓

Q70 Odia
ଏଇଟି  ମୋ' ବାପାଙ୍କର ଗୋଟି ଏ ଛତା I- ଏହି  ବାକ୍ୟର ଇଂରାଜୀ ଅନୁ ବାଦ ଟି  କୁ  ବାଛ।

A.  C. This is a umbrella of my father.

B.  B. This is an Umbrella to my father.

C.  A. This is an umbrella of my father's.

D.  D. It is an umbrella of my father.

✓

Q71 Odia
'ବି ଯୋଜକ ଅବ୍ୟୟ' କାହାକୁ  କୁ ହାଯାଏ ?

A.  A. ଯେଉଁ ଥି ରେ ଦୁ ଇଟି  ବାକ୍ୟକୁ  ଯୋଡାଯାଏ ।

B.  B. ଯେଉଁ ଥି ରେ ଦୁ ଇଟି  ପଦ ବା ବାକ୍ୟକୁ  ପୃ ଥକ୍  କରାଯାଏ ।

C.  C. ଯେଉଁ ଥି ରେ କାରଣ ଦର୍ଶା ଯାଏ ।

D.  D. ଯେଉଁ ଥି ରେ ପରି ମାଣକୁ  ଦର୍ଶା ଯାଏ ।

✓

Q72 Odia
‘ବାଆକୁ  ବତା’- ରୂ ଢ଼ି ର ଅର୍ଥ  ଲେଖ ?

A.  C. ଭି କ ନ ଥି ବା

B.  D. କ୍ଷୀଣ ପବନ

C.  A. ବଡ ବି ପଦକୁ  ଛୋଟ ପ୍ର ତି କାର

D.  B. ଲଗାମ ଛଡା

✓

Q73 Odia
ଏହି  କଲମର ଦାମ୍  ଶହେ ଟଙ୍କା । - ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  ପ୍ର କାର ବି ଶେଷଣ ପଦ?

A.  B. ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  A. ଅବସ୍ଥାବାଚକ ବି ଶେଷଣ

C.  D. ସଂଖ୍ୟାବାଚକ ବି ଶେଷଣ

D.  C. ପରି ମାଣବାଚକ ବି ଶେଷଣ

✓

Q74 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  'ଅକର୍ମ ' ଶଦ୍ଦର ବି ପରୀତ କେଉଁ ଟି  ?

A.  D. କାର୍ଯ୍ୟ

B.  A. ଅକାର୍ଯ୍ୟ

C.  B. କର୍ମ

D.  C. ନି ଷ୍କ୍ରି ୟ

✓

Q75 Odia
"ସେ ପ୍ର ତି ଦି ନ ସକାଳେ ବୁ ଲି ବାକୁ  ଯାଆନ୍ତି  ।" ଏହାର ସଠି କ୍  ଅନୁ ବାଦ କେଉଁ ଟି ?

A.  A. He goes for a walk every morning.

B.  C. He go for a walk every morning.

C.  D. He is going for a walk every morning.

D.  B. He will go for a walk every morning.
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Computer

✓

Q76 Computer
In Windows, which application allows you to quickly search for a file
or folder by name?

A.  A. Control Panel

B.  B. Task Manager

C.  D. File Explorer

D.  C. Device Manager

✓

Q77 Computer
What happens if you try to open a corrupted MS PowerPoint file?

A.  B. The file opens without any issue.

B.  A. An error message appears.

C.  D. The file is deleted.

D.  C. It automatically repairs the file.

✓

Q78 Computer
Which of the following is an example of a cloud storage service?

A.  C. Google Drive

B.  B. Mozilla Firefox

C.  A. WhatsApp

D.  D. Internet Explorer

✓

Q79 Computer
What is the default file extension of a PowerPoint presentation in
the MS PPT 2021?

A.  A. .ppt

B.  D. .pptx

C.  C. .pptm

D.  B. .potx

✓

Q80 Computer
A teacher is preparing to show a presentation to a class using a
projector connected to a laptop. To ensure the presentation appears
full screen on the projector while allowing the teacher to view their
private notes and control buttons on the laptop screen, the MS
PowerPoint 2021 presentation must be set up to use the
________________________.

A.  D. single monitor view

B.  A. presenter view

C.  C. outline view

D.  B. reading view

✓

Q81 Computer
When printing a large Excel worksheet that spans multiple pages,
which of the following methods ensures that column headers
appear on every printed page for better readability?

A.  A. Selecting the “Fit Sheet on One Page” option in the Page
Layout tab

B.  B. Setting “Rows to Repeat at Top” in the Page Setup → Sheet
tab

C.  D. Adjusting the margins to include column titles manually

D.  C. Inserting a header with the column names on each page

✓

Q82 Computer
Which of the following is an example of an e-commerce website?

A.  C. Facebook

B.  B. Amazon

C.  D. Google Drive

D.  A. Zoom

✓

Q83 Computer
What makes documents professional and readable in MS Word?

A.  D. Columns

B.  B. Page break

C.  C. File formatting

D.  A. Page size

✓

Q84 Computer
Which of the following is an example of system software?

A.  D. MS Word

B.  A. Windows Operating System

C.  C. Google Chrome

D.  B. VLC Media Player

✓

Q85 Computer
Which of the following correctly describes the main components of
the CPU and their functions?

A.  B. ALU handles input/output operations; CU performs
calculations

B.  C. CU stores data temporarily; ALU controls instruction flow

C.  A. ALU performs arithmetic/logic operations; CU directs the
execution of instructions

D.  D. ALU stores permanent data; CU handles file management
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✓

Q86 Computer
Which dialog box lets you choose a location like the Desktop to save
your file?

A.  B. Save As

B.  D. Insert

C.  A. Format

D.  C. Print

✓

Q87 Computer
Which option correctly represents the syntax for the SUM function in
Excel to add values from cell A1 to A5?

A.  A. =SUM(A1;A5)

B.  D. SUM(A1:A5)

C.  B. =SUM(A1:A5)

D.  C. =ADD(A1:A5)

✓

Q88 Computer
The decimal number 32 represents which ASCII character?

A.  B. NULL

B.  C. Space

C.  A. Tab

D.  D. New line

✓

Q89 Computer
Which MS Excel formula should you use to display the date in cell B2
in the "mm/dd/yy" format?

A.  A. =DATE(B2, "mm/dd/yy")

B.  C. =FORMAT(B2, "mm/dd/yy")

C.  B. =TEXT(B2, "mm/dd/yy")

D.  D. =CONVERT(B2, "mm/dd/yy")

✓

Q90 Computer
Which of the following steps is used to create a new blank document
in MS Word?

A.  C. Insert → Page → New

B.  A. Home → New Document

C.  D. Review → New File

D.  B. File → New → Blank Document
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Reasoning

✓

Q91 Reasoning
In a certain code language,
Y + Z means ‘Y is the husband of Z’,
Y – Z means ‘Y is the son of Z’,
Y ÷ Z means ‘Y is the wife of Z’.

Based on the above, how is E related to C if ‘E – D ÷ B – A + C’?2335

A.  D. Son

B.  B. Son’s son

C.  A. Daughter’s son

D.  C. Brother

✓

Q92 Reasoning
Ron starts from Point A and drives 46 km towards east. He then
takes a right turn, drives 51 km, turns right and drives 54 km. He
then takes a right turn and drives 63 km. He takes a final right turn,
drives 8 km and stops at Point P. How far (shortest distance) and
towards which direction should he drive in order to reach Point A
again? (All turns are 90-degree turns only unless specified.)

A.  B. 12 km to the South

B.  A. 12 km to the North

C.  C. 12 km to the East

D.  D. 12 km to the West

✓

Q93 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?

BHU91 , IOB78 , PVI65 , WCP52 , ?

A.  B. DJW39

B.  C. DJX39

C.  D. EJW39

D.  A. DUW39

✓

Q94 Reasoning
Select the pair which follows the same pattern as that followed by
the two set of pairs given below. Both pairs follow the same pattern.

UGR : PIM
KKH : FMC

A.  A. AQP : VTK

B.  B. XVT : UAQ

C.  C. XDQ : SHL

D.  D. AOX : VQS

✓

Q95 Reasoning
Seven boxes, Q, R, W, T, E, U, and Y, are kept one over the other, but
not necessarily in the same order.
Only four boxes are kept between T and Y. Only Q is kept above T.
Only two boxes are kept between R and U. E is kept immediately
above W. U is not kept immediately above E.
How many boxes are kept above E?

A.  D. 1

B.  C. 2

C.  B. 3

D.  A. 4

✓

Q96 Reasoning
What will come in the place of ‘?’ in the following equation, if ‘+’ and ‘
– ‘ are interchanged and ‘×’ and ‘÷’ are interchanged?
51 - 21 × 7 + 14 ÷ 2 = ?

A.  A. 26

B.  B. 34

C.  D. 22

D.  C. 42

✓

Q97 Reasoning
Six people, A, B, C, D, E and F, are seated around a round table facing
the centre. D sits third to the right of A. F sits to the immediate right
of E. A sits second to the left of C. Who is sitting third to the left of B?

A.  C. F

B.  D. E

C.  A. D

D.  B. C

✓

Q98 Reasoning
Based on the English alphabetical order, three of the following four
letter cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group? (Note: The odd
man out is not based on the number of consonants/vowels or their
position in the letter cluster)6188

A.  B. MO-PS

B.  D. BD-EG

C.  A. CE-FH

D.  C. GI-JL
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✓

Q99 Reasoning

Read the given statement(s) and conclusions
carefully. Assuming that the information given in
the statements is true, even if it appears to be at
variance with commonly known facts, decide
which of the given conclusions logically follow(s)
from the statement(s).

Statements:
All birds are hats.
All rabbits are hats.

Conclusion (I) : Some birds are rabbits.
Conclusion (II) : Some hats are rabbits.

A.  C. Only conclusion (I) follows

B.  B. Only conclusion (II) follows

C.  A. Neither conclusion (I) nor (II) follows

D.  D. Both conclusions (I) and (II) follow

✓

Q100 Reasoning
Refer to the following series and answer the question. Counting to
be done from left to right only. (Note: All numbers are single digit
numbers only)
(Left) 2 4 6 1 3 5 8 7 2 9 1 6 8 3 5 2 4 1 7 3 8 5 2 4 6 7 9 (Right
How many such even digits are there each of which is immediately
preceded by an odd digit and also immediately followed by an odd
digit?5751

A.  C. 3

B.  A. 4

C.  B. 5

D.  D. 2
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